SynthFont
The concept
SynthFont is a software synthesizer ("MIDI-to-WAV" tool, “Midi Expander”) for playing standard midi files using
SoundFonts ("SF2" files) or other sound files in formats like DLS, GIGA, 404, GUS, SFZ. SynthFont is intended to
mimic the behavior of SoundFont compatible hardware/sound cards like SoundBlaster Live! or Audigy. (SynthFont
is modulator aware, which Live! is not.) But SynthFont is more. It also provides an interface into the SoundFont
structure and has basic midi and SoundFont editing capabilities.
The midi file provides the musical content while SoundFont files provide the sound content. SynthFont can store
arrangement settings for each midi file in an Arrangement file. A typical arrangement setting is the selection of
SoundFonts. SynthFont can also use VST instruments to replace the internal sound engine. One of the main
features with SynthFont is the ability to easily assign different SoundFonts to difference MIDI channels.
These assignments are the stored in the Arrangement file.
With SynthFont you do not need any particular sound card. In fact, if you only want to render audio files (".WAV"
files) you don't even need a sound card at all.
The first thing to do before loading a midi file is to select the default SoundFont. SynthFont will ask you to do it the
first time you run it. You can change the default SoundFont later (go to the Files... menu to find this function). The
default SoundFont is used whenever an "unknown" midi file is loaded for which there is no SoundFont information
available. (Note that if there exists a SoundFont file having the same base name as the midi file in the path, then
that will be used and assigned to all channels instead of the default SoundFont.) The default SoundFont should
preferably be a GM (General Midi) SoundFont, i.e. a SoundFont with programs/presets for all 128 instruments
defined by the GM standard. The SynthFont installation package includes the most basic GM SoundFont of all: the
SYNTHGMS. If you want a better alternative then download a file from SynthFont's web page. (The files there are
in a compressed format (sfArk) but SynthFont can decompress it.)
There are three user levels: ”Just Playing”, ”Midi Guru” and ”Expert Wizard”. You can change mode in main menu
View.:

The only difference between these modes is in the number of pages displayed in the Page Control:

In “Expert Wizard” mode you have access to eight tabs:
1 Files & Folders - to use the file Playlist or the inbuilt Explorer
2 Pianoroll - to inspect and edit the midi file
3 Midi events - for in-depth inspection and editing, only for die-hard experts!
4 Plug & Play - this is where all the fun begins. The image above shows this screen. At the top you have the synth

rack, with a few things you can change. Below this you have the tracks list, which also gives you access to a
number of parameters. For example, to change the SoundFont for a particular track, select it and press the "SF
File" button in the list heading or then "SoundFont File..." button in the main toolbar.
5 Preset layers - only of interest if you want to see what a SoundFont contains
6 Splits in layer - only of interest if you want to see what a SoundFont contains
7 Sample data - only of interest if you want to see what a SoundFont contains
8 Info - some information may be displayed here
The tabs in italics are not visible in Just Playing mode, while pages 5,6 and 7 are not visible in “Midi Guru” mode.
But please note that pages 5, 6 and 7 may sometimes be hidden in “Expert Wizard” mode also (for instance when
the selected track has a VST instrument assigned).

The main toolbar:

The buttons in the main toolbar are: ”Exit”, to exit the program; ”Setup and Options”, to change a number of
settings and install VST effects and instruments; ”Save Arrangement”, to save the selection of SoundFonts, VST
effects and instruments and other similar settings into a file (NOTE: press RIGHT mouse button to pop up the Save
As... alternative); ”Open Midi or Arrangement”, to open a midi file or its arrangement (press right mouse button for
a list of your Arrangements); ”SoundFont File...” , to open a SoundFont and assign it to a midi channel (press right
mouse button for a history list); ”Play to Speakers”, to play the midi file to the standard audio output (speakers or
headphone); ”Play to File”, to create and audio file suitable for writing a CD, ”Play to Both”, to send the audio to
both standard output and a file (slower than just using ”Play to File”), ”Turn Midi Input ON”, to play not from a midi
file but in real time from a midi input port source to which for instance a keyboard could be connected; ”Save Midi”,
to save a midi file which you have edited.

The main screen:

The image above shows the page ”4 Plug & Play” - one of the 8 pages which are accessible from the main window.
The pages are ”1 Files & Folders”, ”2 Pianoroll”, ”3 Midi events”, ”4 Plug & Play”, ”5 Preset layers”, ”6 Splits in
layer”, ”7 Sample data” and ”8 Info”. Of these pages, numbers 2, 3 and 4 shows data from the midi files, while 5, 6
and 7 shows data from currently selected SoundFont. The table in the lower half lists the tracks in a midi file. To the
right is a very basic mixer.
Normally each track references one, and only one, midi channel. Note, that often the same midi channel is used by
many tracks. You only see the screen like this, showing the pane ”4 Plug & Play”, when you have a midi file
loaded. Before that you will see the screen showing ”1 Files & Folders”:
This page is divided into two parts: the upper part is for creating and manipulating playlists, while the lower part is a
normal files and folders explorer.
The Plug & Play page is divided into three parts. The upper part contains quite a few functions related to how the
synth engine processes the midi data. The middle part contains a number of important buttons. The lower part
simply shows a list of tracks and midi channels in the midi file. A midi file may contain any number of tracks, but
only 16 midi channels. Data for a particular midi sequence can be split into several tracks while still playing through
one single midi channel. Most arrangement settings in SynthFont are related to the midi channel and not the track.
For example, you can assign different SoundFonts (or VST instruments) to each of the 16 channels, but not to each
of the N tracks. Thus, if two tracks plays through the same channel, they will also share the same SoundFont.

The Plug & Play upper part:
Beats Per Minute: The midi file contains data that defines the BPM for the song. This data may change or remain
the same. You can change the overall playback speed by changing the Speed factor. Use the four up/down buttons
to change the factor in units of tenths (”.1”) or hundreds (”.01”). It is possible to create an automation which can be
stored in the arrangement file, although it is probably better to edit the BPM data in the midi file directly then. You
can activate a metronome that wil click at the current BPM speed.
Playback volume: There are two sliders you can pull, Left and Right. Normally these are synced to each other and
change at the same time. To change them separately you need to un-toggle the Sync button. Above the Sync
button there is a Soft button. Toggle this to activate a soft limiter for reducing the distortion when the signal
becomes too high. At the top is the Auto button for manipulation of automations for the volume (again it is probably
wiser to edit the volume data in the midi file directly).
Output VST Effects (”Fx”): You can assign third party VST effects to 17 separate lines, or ”busses”. The first bus
is the Main bus, which is always used by all midi channels. The other 16 busses can be assigned to each midi
channel separately. Below the ”Bus chain” drop-down list there are six buttons for manipulation of VST effects. You
have to install or register VST effects at first in ”Setup and Options” before you can use them.
Playback progress: The two small triangles below the progress bar can be pulled to define the Bar/Beat playback
range. There are seven small buttons: play/stop, forward one or ten bars, pause, forward to next marker, backward
on or ten bars, back to previous marker, and create a mew marker. (Markers can be seen and manipulated in the
Pianoroll pane).
Synth Options button: This buttons opens the Setup and Options dialog and goes directly to the Synth options in
the dialog.
Playback Range: Here you can define what part of the tune you want to play. You can select to use Markers,
which are either defined in the midi file or later by you (and stored in the arrangement file)., you can also select ti
play an area defined by a set of Bar and Beat numbers. The Playback range is also visible in the playback
percentage box to the left, where the markers are show as two vertical lines in the progress bar, and the Bar/Beat
start and stop values are shown as two small triangles below the progress bar. If you have selected a Playback
range, you may select to loop it a number of times or indefinitely.
Voices: this is also for information only, it shows the number of simultaneous voices, or wave samples, playing at
the same time (often referred to as “polyphony”). SynthFont can at most handle up to 512 voices, but your CPU
may put limitations on the number you can reach without cause disruptions in the audio output. NOTE that when
playing to a file, there is no CPU limitation.
CPU: this is for information only, it shows the CPU load while playing.

The Plug & Play middle part:

In the middle part there are two row of buttons. In the top row, left to right, there is
1. Fit the contents of the tracks list to the available space. Normally this is done automatically.
2. Play the select track(s) solo (thus, mute all other tracks). This selection can be stored in the arrangement
file. NOTE that solo only means that notes in other tracks are muted. Midi controllers are still active and
may cause unexpected effects, like pitch bend or a midi program change.
3. Mute the selected track(s). Note that this will only mute note data, other midi events, like program changes
and controllers are still active. This selection can be stored in the arrangement file.
4. Play notes in selected track(s). This is the opposite of mute.
5. Inactivate ALL events in selected track(s). Now, not only notes, but all other events will be ”silent” also.
This selection can be stored in the arrangement file.
6. Activate ALL events in selected track(s). The opposite to inactivate.
7. Press the ”home” button if you have got lost. It will restore or activations to the default level.
8. Create a new midi track. This will have to be saved in the midi file as a new track.
9. Create a new audio track. You can play an audio file alongside with the midi data. Use this button to create
a track and assign the audio file to it. This data is not stored in the midi file but in the arrangement file.
10. Change the audio track's data.
11. Arm an audio track for recording audio data from a standard input source (defined in Setup and Options)
12. Delete the selected track
13. Open the SoundFont of the selected track in Viena SoundFont editor (if installed)
14. Change midi channel slot. Internally SynthFont can use up to 32 midi channels. The midi specification only
allows 16. You can change the internal channel number easily with this button. Channel 3 will become
channel 19 (3+16) and so on. Note that internally (and by specification) channels are numbered 0 to 15,
but if you rather use the range 1 to 16 you can change this in Setup and Options.
15. Add a track layer to the selected track. This layer can have other SoundFonts and instruments defined
than the parent track. It will use the same midi data though, so data is not duplicated.
16. Edit/create group file. A group file is a collection of SoundFonts that you can use instead of any single
SoundFont. Thus, if you are happy with most of the instruments in your default SoundFont, but not with the
Cello, you can define another SoundFont to override the original Cello. This overriding SoundFont can
either be a another GM SoundFont or a simply a single instrument Cello SoundFont.
17. Set pan spread parameters. This is a very special function for playing piano tunes. Use this if you want to
create a more realistic spatial spread of the notes.
18. Show/hide virtual piano. Use the virtual keyboard for listening to instruments in the SoundFont.
19. Show the Sound File Manager. This is a tool you can use to audition the Presets in your collection of
sound files in order to choose the most suitable Preset for the tune.
20. Mixer: “Q Standard” / “R Extended”. Se the section below on use of the Mixer.
The second row of buttons actually belongs to the tracks list, which is described below.

The Plug & Play tracks list:
The header of the tracks list also contains a number of important buttons:
1. Tr# - press this button to open a tool for rearranging the tracks. The change can be save in either the midi
file or the arrangement file.
2. Name – press to edit the name of the track.
3. CHN – use this button to override the channel value. You can use this button to switch between the
channel slots.
4. BANK – use this button to display the bank setup. Banks are explained in details in a later section.
5. MIDI Program – press to pop up a menu of General Midi programs (all 128). You can use this to change
the program defined in the midi file. NOTE that this is NOT an Arrangement feature and you need to save
the midi file for this change to become permanent. Also NOTE that a track may contain more than one midi
program change. In the example above four tracks display the midi program in bold, meaning that there are
more program changes. When you select one of these tracks, a new button next the program name will
appear: “Select”. Press this button to pop up a menu of program changes.
6. SF File... – press to search for a suitable SoundFont (or other Sound File). You can also select a file from
the history drop-down list
7. VSTi – use this button to select a VST instrument to be used instead of a SoundFont. Again you can pick
one directly from the drop-down list
8. Out (Midi Out) – press to select a Midi Out Port to send the midi data to. SynthFont will not internally play
the data then,
9. SF2 Preset – use this button to select the instrument to be used if you want to override the default midi
program choice. (Internally SoundFont instruments are called ”presets” because a ”preset” is built up of one
or several instruments. See the section on SoundFont structure).
10.FxBus – select a VST effects bus from the menu.
11.PSM – PSM stands for Pitch Shifting Method. Pitch Shifting is used to create audio for notes which are not
directly stored in the SoundFont. The more the original audio data has to be shifted away from its root note,
the bigger is the risk for artificial secondary noise, or aliasing effects. The better PSM method called
Perfect Pitch gives better results in cases like these, but is much slower and CPU power consuming than
the standard method. Use carefully!
12.MIXER – press this button to select a so called mixer function. Mixer data is stored in the arrangement file.
There is a context sensitive menu that can be displayed for the tracks by pressing the right mouse button.

Tracks and Midi Channels
SynthFont is midi channel oriented - like any hardware synth. Midi files are often organized in tracks. SynthFont
handles tracks, but is very much channel aware, which means that many things you do in the arrangement effects
all tracks referencing a certain midi channel. For instance, when you assign a SoundFont to a track you actually
assign it to the Midi Channel, which means that the SoundFont will change for all other tracks using the same Mid I
Channel. Each track can reference any number of channels and two or more tracks can share the same channels.
There are 16 channels in the standard midi implementation. This is an unnecessary limitation for a software synth,
and SynthFont internally can use any number of channels. Currently 32 channels are available. (Midi channels are
usually numbered 0-15 (and 16-31) or 1-16 (and 17-32) (you can choose the numbering scheme). The percussion
channel is by default channel 9 (or 10), although in SynthFont you can freely assign a percussion bank to any
channel
The Mixer
There are two alternative mixers: the “Standard” and the “Extended”. The Standard mixer is available also to users
without a registration license, while the Extended mixer is open only to registered users. The Standard mixer lest

you edit only one parameter at a time. You can choose the parameter from the drop-down list at the button at the
top (reading “Volume” in the image above). There parameters are:
Volume: Changes the overall volume of the TRACK (not for the MIDI channel). Note that the range is much larger
than the normal MIDI channel volume range.
Pan position: Changes the overall pan position of the TRACK (not for the MIDI channel).
Vel Dynamics: Each note has its own velocity value. The Vel Dynamics changes the range of these velocity
values. Note that the lower limit is always 0.0 (N/A = not applied) but the upper limit is much higher than the MIDI
upper limit.
Transpose: Changes the note values up/down in steps of semitones
Transpose all: Changes the key of the tune up/down in steps of semitones.
LP Filter type: All three filter alternatives are Low Pass filters of the same basic type but with varying degree of
slopes.
LP Filter amount: The amount of signal sent to the Low Pass filter. 0% = none, 100% = all.
You can either edit the values directly in the cells or use the scrollbar. You can also use a context sensitive menu
(right mouse button) for setting some default values:
This menu also shows some available keyboard shortcuts.
The extended mixer lets you edit four values at the same time. Now there is no trackbar, but you can use the
up/down spinwheel instead:

Keyboard shortcuts
ctrl+A = save midi file
shift+ctrl+A = save midi file AS
ctrl+B = bank manager
ctrl+C = decrease mixer value, fine
ctrl+D = Define Default SoundFont Overrides
ctrl+E = add vst effect to bus
shift+ctrl+E = remove vst effect
ctrl+F = increase mixer value, fine
ctrl+G = edit group file
ctrl+H = Define default SoundFont
ctrl+I = activate/inactivate track
ctrl+J = shift BPM factor down 0.01 step (fine)
ctrl+K = show/hide Virtual Keyboard
ctrl+L = add track layer
ctrl+M = mute/unmute notes
ctrl+N = new midi
ctrl+O = reopen midi file
ctrl+P = play track solo
ctrl+Q = stop playing
ctrl+R = arm for recording audio
ctrl+S = save arrangement
shift+ctrl+S = save arrangement as
ctrl+T = Show/hide Karaoke Lyrics
ctrl+U = shift BPM factor up 0.01 step (fine)
ctrl+V = playback volume up
shift+ctrl+V = playback volume down
ctrl+W = show Sound File Manager
ctrl+X = (unused)
ctrl+Y = (unused)
ctrl+Z = (unused)
Alt+A = show Piano Player window

Alt+B =
Alt+C =
Alt+D =
Alt+E =
Alt+F =
Alt+G =
Alt+H =
Alt+I =
Alt+J =
Alt+K =
Alt+L =
Alt+M =
Alt+N =
Alt+O =
Alt+P =
Alt+Q =
Alt+R =
Alt+S =
Alt+T =
Alt+U =
Alt+V =
Alt+W =
Alt+X =
Alt+Y =
Alt+Z =
Alt+"-"

play to both (speakers and file)
set loop count
open Edit menu
open Setup dialog
open File menu
play next song (playlist)
open Help menu
(unused)
(unused)
(unused)
toggle loop
toggle metronome (fixed)
(new midi track, F9)
open an arrangement or midi file
open Play menu
show mixer standard view
show mixer combo view
play to speakers
open SF2-tools menu
assign soundfont file (F3)
open View menu
write to file
exit
synth options
Freeze BPM factor
= show VST-Fx (VST-Effects) menu

Alt+1..+8 + change pane
F2 = rename track
F3 = assign soundFont to program change in track
F4 = assign soundFont preset to program change in track
F5 = Setup and Options
F6 = go to Tracks list
Alt+BkSp = restore mute and activation to default
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P
Q
R
S
T
U
V
W
X
Y
Z

=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=

show mixer transpose all
(unused)
decrease mixer value, course
show mixer velocity dynamics
Setup/Options
increase mixer value, course
play next song (playlist)
(unused)
(unused)
shift BPM factor down 0.1 step (course)
(unused)
show mixer low pass filter type
show mixer low pass filter amount
(unused)
(unused)
show mixer pan
show mixer standard view
show mixer combo view
set mixer value to default
show mixer transpose
shift BPM factor up 0.1 step (course)
show mixer volume
pause playback (also Pause/Break key works)
set mixer value to maximum
(unused)
set mixer value to minimum

HOME = start/stop playback to speakers (instead of SPACEBAR, See Setup to change)

Short description of the SoundFont structure

The SoundFont specification and structure IN SHORT
SF Bank

Layers

Splits

Preset 1

Instrument1
Instrument2
Instrument3
Instrument4

Split1
Split2
Split3
Split4

Preset 2

Wave sample data

The overall structure of a SoundFont is described above. The Preset (also often referred to as an ”instrument”,
a “program”, or a “patch”) is the feature that is visible to the outside. Presets are combined into Banks. Each Bank
can hold 128 Presets and these are numbered either from 0 to 127 or 1 to 128 (in SynthFont 0-127). There can be
128 Banks (numbered 1-128 or 0-127). Hence the total number of Presets in a SoundFont file is large enough.
Very few SoundFonts have more than a few Banks in use. Usually these are “variation banks”, .i.e there may be a
slightly different Acoustic Piano in Bank 1 Preset 0 (1:0) than in 0:0.
A Preset may have one or more Layers. In the simplest case there is only one Layer, which then has to cover the
whole key range and also the whole velocity range. The sound data used for a Layer is called an Instrument. The
Instrument structure usually contains all the information needed to create the sound. Hence, in the simplest case,
the Preset has only one Layer, referring to one single Instrument. NOTE: Instruments are pooled, meaning that
several Presets may share the same Instrument. This is cost effective but also a risk. When you edit an Instrument,
be sure to check what happens with ALL Presets making use of this Instrument.
A Layer may contain parameters (usually called “generators”) that can alter the sound of an Instrument. So,
although two Presets may share one single Instrument, they may sound differently due to the Layer’s data.
Layers are often used to separate key and velocity ranges, but this is no rule. Many Presets are “artificially” created
by layering several Instrument sounds on top of each other. Another very common use is to add stereo to the
sound with Layers. The wave samples used in a SoundFont file are always monophonic. A stereophonic wave
sample is hence split up into two monophonic wave samples (labeled e.g. “Horn (L)” and “Horn (R)”) and two
Instruments may two be created for these horn sounds. In the layers, these two horn Instruments are then included
on top of each other, but panned hard left and right. Artificial stereo may be created in the same way by having one
instrument in two layers slight tuned off up and down (and panned, of course).
Instruments, again, are structured in Splits. Usually, a split is used for a certain key and/or velocity range. A split
always uses one single wave sample for the sound and has generators that can alter the sound. Instruments often
need to make use of several splits and samples for a particular sound. For a real world instrument, the pitch range
is so large that it cannot be recreated in a synthesizer just be manipulating one single sample. Hence, many
samples are recorded and assigned a root note. Typically one sample can cover a key range equal to root note ± 5
notes. Velocity splits are also common. Typically the same sample is used, but with different attenuation level,
frequency filter and attenuation envelope.
One sample may be used by menu splits and Instruments. This is normally the case. Again, this is cost effective
but potentially a risk. If you replace one sample with another then it may have unexpected side-effects.
All in all, it is important to understand that there are MANY parameters (usually called “generator) that are involved
when creating a Preset sound, and it may be a very CPU power consuming task.

